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Formulas, Functions and Charts

8.1 INTRODUCTION

In this leson you can enter formula and functions and perform

mathematical calcualtions. You will also be able to create charts

and graphics using the data. You can specify methametical

relationship between the numbers using the formula. Formulas

are used for simple addition, subtraction, multiplication and

division as well as for complex calculations. Functions are built

in formulaes. The users have to provide cell references and

addresses only. These are called arguments of the function and

are given between the left and right parenthesis.

8.2 OBJECTIVES

After going through this lesson you would be able to:

l use formulaes to get the desired result

l insert and edit picture from a file

l use functions

l create varioius charts

l draw graphics using clip art.

8
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8.3 FORMULAS AND FUNCTIONS

To manipulate data and to extract useful information from Excel

worksheets, formulas and worksheet functions play very

important role. In Excel, formulas are used to calculate results

from the worksheet data. When there is some change in the data,

such formulas automatically calculate the updated results with

no extra efforts on the part of the user. There is a new feature

introduced by Excel 2007, which enables you to create formulas

which use columns names from a table, when you are working

with table. This feature helps the user to make formulas much

easier to read.

A formula can have any or all of the following elements

l Must begin with the 'equal to' = sign.

l Mathematical operators, such as + (for addition) and / (for
division) and logical operators such as <, >

l References of cell (including named ranges and cells)

l Text or Values

l Functions related to the worksheets, for example  SUM or
AVERAGE

The current cell in which you have entered a formula will display
the result after the formula is completely entered. Also, when you
select or click on a cell which is having some formula, the formula
will appear in the formula bar.

In Excel 2007, the formulas are available in the Formulas Tab. If
you click on the Formulas tab, you can see the corresponding
ribbon display with available formulas, as shown below.

Fig. 8.1

Formula

Bar
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Following are a few examples of formulas:

Fig. 8.2

In the above example, in the cell F3, just type = B3+C3+D3+E3.

It will return sum of the marks in physics, chemistry, maths and

English.

Fig. 8.3
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Copying a formula

In above exaple just drag the handle and bring down to cover the

remaining cells in the column total. This will automatically copy

the formula and calculate the corresponding sum of the

respective rows of the other students.

Fig. 8.4

Some other examples of formulaes:

If A1 = 2, B1 = 3, C1 = 4, D1 = 5 then

(i) = B1 * C1 will give result as 3 * 4 = 12

(ii) = A1 * B1 – C1 + D1 will give result as 2 * 3 – 4 + 5 = 7

(iii) = ((A1 * B1) + C1)/D1 will give result as ((2 * 3) + 4)/5

= (6 + 4)/5 = 10/5 = 2

Auto sum feature

The sum of cell values can also be done with the help of AutoSum

feature also.

Following steps explains how to do that.

l Click on the cell F3.

l Select the Formulas tab

l Click AutoSum from the function library group.
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l Select Sum

l Press Enter

Alternatively, you can write = SUM(B3:E3) in the Cell F3 to get

the sum of the Physics, Chemistry, Maths and English marks.

Pictorial illustration is shown below:

Fig. 8.5

Apart from sum there are other functions also, like average, Count

Numbers, Max, Min and many other Functions.
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Fig. 8.6

Sum ( ) : Adds all the numbers in a range of cells.

Syntax SUM(number1,number2, ...)

Maximum number of arguments can be 255 i.e. number1,

number2 ... number255.

Sum function is having different forms. You can choose as per

your need.

Fig. 8.7

SUMIF(range, criteria, sum_range) : This form of sum functions

is used to add the cells with respective to a given criteria.

Range : A group of adjacent cells
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Cells within a range must be numbers or names, arrays, or

references which are having numbers. In sumif function the

blank and text values are ignored.

Criteria: It can be a number, expression, or text to define which

cells will be considered for the addition e.g. criteria can be fixed

as 12, “12”, “>12”, or “mangoes”.

Sum_range: These are the actual cells to be added if their

corresponding cells in range match criteria. In case the

sum_range is avoided, then the cells in range are both evaluated

by criteria and added if they match criteria.

Example

In above examples, the function SUMIF adds only those values

in the cells (B3, E3) which are greater than 99. i.e., it will add the

values from cells D3 and E3 only and hence the result is 100 +

100 = 2000

Fig. 8.8

E3
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Average function ( ) : It helps you to get the average of the

numbers. It returns the average (arithmetic mean) of the

arguments.

Syntax :  AVERAGE(number, number2,...)

Maximum number of arguments can be 255 i.e. number1,

number2 ... number255.

Fig. 8.9

Min function ( ) : It helps you to get the minimum of the

numbers.Returns the smallest number in a set of values. Syntax

MIN(number1,number2,...)

Maximum number of arguments can be 255 i.e. number1,

number2 ... number255

Fig. 8.10
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Max function ( ) : It helps you to get the  maximum of the

numbers. Returns the largest number in a set of values. Syntax

MAX(number1,number2,...)

Maximum number of arguments can be 255 i.e. number1,

number2 ... number255.

Fig. 8.11

Now drag the handle of cells G3,H3,I3,J3 to cover each row of the

respective column. You can see the corresponding functions are

automatically copied in the respective columns and automatically

values are calculated. See the figure below.

Fig. 8.12

331 0 82.75 77 88
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To use more functions

l Select Formula Tab

l Choose AutoSum from function library group, from formula

ribbon

l Click on More Functions… as shown below.

Fig. 8.13

When you click on more functions, a dialog box will appear as

shown below. You can choose a function as per your need by the

help of following dialog box.

Fig. 8.14
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8.4 CHARTS

Charts allow you to present data entered into the worksheet in a

visual format using a variety of graph types. Before you can make

a chart, you must first enter data into a worksheet. This section

explains how you can create simple charts from the data.

Formatted charts come in various types for diverse goals, ranging

from columns to pies, from lines to surfaces, etc.

8.4.1 Types of Chart

Microsoft Office Excel 2007 provides various types of charts to

help you to display data in different ways as per the need of the

viewers. You can create a new chart or can change the existing

chart, from the wide range of chart subtypes available for each

type of available chart types as given below

Column Charts

This type of chart is used to compare values across categories.

They give very effective results to analyze the data of the same

category on a defined scale.

Line Charts

Data represented in columns or rows in a worksheet can be

plotted with the help of line chart. Line charts can be used to

display continuous data over time with respect to a common

scale. Thus Line Charts are best suitable for viewing data trends

at equal intervals of time. The horizontal axis is used to represent

the category data and all the value data is distributed uniformly

along the vertical axis.

Pie charts

In a situation where one has to show the relative proportions or

contributions to a whole, a pie chart is very useful. In case of pie

chart only one data series is used. Small number of data points
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adds more to the effectiveness of pie charts. Generally there

should be maximum five or six data points or slices in a pie chart.

If the points are more in number then it becomes very difficult

to interpret the chart.

Also, it is very important to note that the values of to be used in

the pie chart must be all positive. If there are some negative

values, in that case the negative values will be automatically

converted in to positive values, this will be desired.

Bar Charts

Bar charts are used to show comparisons between individual

items. To make a bar chart the data should be arranged in the

form of rows and columns on a worksheet.

Area Charts

The data which is arranged in the form of rows or columns on a

worksheet can be plotted in an area chart. Area charts are used

to highlight the degree of a change over time. Area charts are also

used to draw attention to the total value across a trend.

XY (Scatter) charts

XY charts are also known by other names like scatter grams or

scatter plots. The point of difference between XY charts and other

types of charts is that in XY charts both axes display values i.e.

they have no category axis. Such type of charts is generally used

to show the relationship among two variables.

Stock charts

Stock chart can be used to plot data arranged in columns or rows

in a particular order on a worksheet. As the name is self

explanatory, this chart is used to demonstrate the fluctuations

with respect to stock market prices. Even scientific data can be
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plotted by stock chart, e.g., the fluctuation of daily or periodic

temperature. The data must be arranged in a correct order to

generate stock charts. Say, for example to make a simple high-

low-close stock chart one should organize his/her data with High,

Low and Closed entered as the headings of the columns in the

respective order.

Surface charts

Such type of chart is used in situations where both categories and

data series are numeric values. This type of chart is useful in

situations where the optimum combinations are found among the

two sets of data. Data should be arranged in columns or rows in

a worksheet can be plotted in s surface chart. The colors and

patterns indicate the areas which are in the same range of set of

values, as it happens in case of a topographic map.

Doughnut charts

The conditions to draw doughnut charts is that the data has to

be in the form of rows or columns. As in the case of a pie chart,

the doughnut chart illustrate the relationship of parts to a whole,

but it is able to get more than one data series.

Bubble charts

A bubble chart can be used to plot the data values which are

arranged in the columns of a worksheet so that x values are listed

in the first column and matching y values and bubble size values

are listed in adjacent columns.

Radar charts

The radar charts compare the aggregate values of a number of

data series. Radar chart can be plotted with the data which is

arranged in columns or rows on a worksheet.
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8.4.2 Components of a Chart

Fig. 8.15

Chart Title - A title given to the whole chart.

X-Axis Title - A title given to the X-axis data range.

Y-Axis Title - A title given to the Y-axis data range.

X-Axis Category - These are the categories of the data which have

been plotted. These are taken from the first column or first row

of your data range.

Y-Axis Value - This is the data range marked to plot the data

series.

 Vertical Major Grid 
Y Axis Title 

Y Axis 

Value Horizontal Major Grid 

Data 

X Axis 

Categor

y 

Chart Title 

 

Tick 

Mark 

Legend 

X Axis 

Title 
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Data Labels - The values of the data series plotted.

Legends - Specifies the colour, symbol or pattern used to mark

data series.

Tick Mark - These marks are used to show the scaling of X-axis

and Y-axis.

Grid Lines - Displays lines at the major intervals on the category

(x) axis and/or Y-axis

How to Draw a Chart in Excel 2007

In Microsoft Excel 2007 chart wizard is removed and also not

brought back in Excel 2010 also. Instead the ribbon is provided

as a new place to get your chart related needs full filled. The

buttons on the Insert tab of the ribbon are just the starting point

to make a chart. After we get the ribbon it becomes very simple

to start making a chart. Whenever we click on some component

of chart, we observe that the Chart Tools are displayed to the

ribbon. Three additional tabs which provide a variety of chart

design, layout and formatting options, will also be added.

First, the Layout tab, is used to add all sorts of elements related

to chart or change the way they are shown in the chart. Second,

the format tab is used to apply special effects which were not

available in the earlier versions of the Excel, such as the bevel

effect etc. It may be little difficult to be acquainted with this new

type of chart interface, but once you start working, you’ll be proud

to show off your professional looking results.

It is worth mentioning that you can right click on an element of

the chart for quick access to specific features with respect to that

particular element e.g. if you right click on any chart axis, you will

get Format Axis dialog box.

Following steps are given to draw a Chart

1. Enter data in the work sheet: Suppose you entered data as

given in Fig. 8.16.
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Fig. 8.16

2. Now select data range: By using the mouse high light the

range of data you want to take (see Fig. 8.17).

Fig. 8.17

3. Click Insert Tab and select a chart type from the chart

group
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Fig. 8.18

4. Select the sub type of chart

Fig. 8.19

Fig. 8.20
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5. Select the Title of the chart

a. To give a title to a chart, click on the chart. Now you

can see layout tab available. Click on Layout tab.

b. Choose(click) on chart title option available in the

Label group

Fig. 8.21

Fig. 8.22
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c. Click on the chart title and write a title.

Fig. 8.23

6. Give a name to X-Axis

Click on Layout tab. Then select Axis Titles from Labels

Group. Select Primary Horizontal Axis Title, as shown

below.

Fig. 8.24
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Fig. 8.25

Now, click on the Axis Title and write an X-axis title.

Fig. 8.26

Follow the same steps to give a title to Y-axis.
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Fig. 8.27

Fig. 8.28
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Editing of a Chart

1. How to change the legend position

Click on Layout tab. Then click on Legend option available

in Labels Group.

Now choose a position to show legend.

Fig. 8.29

Fig. 8.30

2. How to change the position of the Data Labels

Click on Layout tab. Then click on Data Label option

available in Labels Group.

Now choose a format to display data labels
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Fig. 8.31

Fig. 8.32

3. How to show Data Tables Along with Chart, with or

without Legend Keys

Click on Layout tab. Then click on Data Table option

available in Labels Group.

Now choose a style to display data table
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Fig. 8.33

Fig. 8.34

Above diagram show the data table with legend option.

4. How to Hide/Unhide Grid Lines (Horizontal and Vertical)

Click on Layout tab. In the Axis Group, click on Gridlines

option then choose Primary Horizontal Grid Lines. Now

select appropriate style from the available options (None,

Major Gridlines, Minor Gridline, Major and Minor Gridlines)
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Fig. 8.35

Fig. 8.36

Follow the same steps for Vertical Grid Lines also, as shown

below.

a) Click on Layout tab. In the Axis Group, click on Gridlines

option then choose Primary Vertical Grid Lines.

 

No Horizontal Major 

Grid Lines 
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b) Now select appropriate style from the available options

(None, Major Gridlines, Minor Gridline, Major and Minor

Gridlines)

Fig. 8.37

Fig. 8.38

8.4.3 Resizing the Chart

To resize the chart, click on its border and drag any of the eight

black handles to change the size. Handles on the corners will

 

Vertical Grid lines for 

Major Units are added 
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resize the chart proportionally while handles along the lines will

stretch the chart.

8.4.4 Moving the Chart

Select the border of the chart, hold down the left mouse button,

and drag the chart to a new location. Elements within the chart

such as the title and labels may also be moved within the chart.

Click on the element to activate it, and use the mouse to drag

the element to move it. Microsoft Excel automatically sizes titles

with respect to the size of the text. One can move titles with the

mouse but, cannot resize them.

8.4.5 Copying the Chart to Microsoft Word

A finished chart can be copied into a Microsoft Word document

or power point slide. Select the chart and click Copy. Open the

destination document in Word or a slide in power point and click

Paste.

8.5 GRAPHICS – AUTOSHAPES AND SMART ART

The AutoShapes feature of Excel 2007 allows you to draw a

number of geometrical shapes, arrows, flow chart elements, stars,

and more on the worksheet.

The steps to activate and use AutoShapes are

1. Click on Insert Tab.

2. From Illustrations Group, Click on Shapes

Fig. 8.39
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Now Select the which you want to insert.

Fig. 8.40

Fig. 8.41
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Different categories of AutoShapes available in Excel 2007. We

will briefly discuss some of the here.

1. Lines - After clicking the Lines button on the AutoShapes

toolbar, draw a straight line, arrow, or double-ended

arrow from the first row of options by clicking the respective

button. Click in the worksheet where you would like the line

to begin and click again where it should end. To draw a

curved line or freeform shape, select curved lines from

the menu, click in the worksheet where the line should

appear, and click the mouse every time a curve should

begin. End creating the graphic by clicking on the starting

end or pressing the ESC key. To scribble, click the last

button in the second row, click the mouse in the worksheet

and hold down the left button while you draw the design.

Let go of the mouse button to stop drawing.

2. Connectors - These lines can be used to connect flow chart

elements.

3. Basic Shapes - Click the Basic Shapes button on the

AutoShapes toolbar to select from many two- and three-

dimensional shapes, icons, braces, and brackets. Use

the drag-and-drop method to draw the shape in the

worksheet. When the shape has been made, it can be

resized using the open box handles and other adjustments

specific to each shape can be modified using the yellow

diamond handles.

4.  Block Arrows - Select Block Arrows to choose from many

types of two- and three-dimensional arrows. Drag-and-

drop the arrow in the worksheet and use the open box and

yellow diamond handles to adjust the arrowheads.

5. Flow Chart - Choose from the flow chart menu to add flow

chart elements to the worksheet and use the lines menu

to draw connections between the elements. We have drawn

a flowchart using lines, flow chart elements and connectors.

6.  Stars and Banners - Click the button to select stars,

bursts, banners, and scrolls.
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7. Call Outs - Select from the speech and thought bubbles,

and line call outs. Enter the call out text in the text box

that is made.

Smart Art Graphics

Visual representation of information and ideas is called SmartArt

Graphics. They can be used to quickly, easily and effectively

communicate a message. The facility to create a SmartArt Graphic

is available in MS Excel 2007. You can copy and paste SmartArt

graphics as images into other programs such as Word and

Powerpoint.

To create a SmartArt graphic, one has to choose a type for

example, Process, Cycle, Hierarchy or Relationship. A type

represents a category of SmartArt graphic. Each type is having

several different types of layouts.

Steps to Create a SmartArt

1. Click on Insert Tab.

2. From Illustrations Group, Click on SmartArt

Fig. 8.42
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Fig. 8.43

3. Now choose a category (Say Hierarchy) and click OK.

Fig. 8.44

4. Now you can enter the values as shown below. To enter

values just click on the component where you want to enter

text and write the text.
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Fig. 8.45

You can apply different effects on the SmartArt, by the help of

Design tab. Click on SmartArt. The Design tab will be visible with

its ribbon. Select appropriate group from the ribbon and apply

the desired effects.
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Fig. 8.46

8.5.1 Adding Clip Art

Clip is  a single media file, including sound, animation, art or

movie.

Steps to insert a Clip Art

1. Click on Insert Tab.

2. From Illustrations Group, Click on Clip Art

3. Then Select a Collection and press Go Button

4. Click on a clip from the collection
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Fig. 8.47

Fig. 8.48

Fig. 8.49
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5. Clip will be inserted in the worksheet.

Fig. 8.50

6. To edit the clip, Just click on the clip. This will display

Format tab. Choose the relevant group from the ribbon of

Format tab and do the necessary changes.

Fig. 8.51

8.5.2 Inserting and Editing a Picture from a File

Follow these steps to add a picture, photo or graphic from an

existing file:
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1. Click on Insert Tab.

2. From Illustrations Group, Click picture.

Fig. 8.52

3. Now select a picture from the location of the picture (where

you have stored the picture) and press enter or click on

insert button.

Fig. 8.53

4. The picture is added on the excel sheet. Click on the

picture to activate Format tab as shown below along with
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its ribbon showing groups like Adjust, Picture Styles,

Arrange and Size. Use any of the groups to make necessary

changes in the picture appearance.

Fig. 8.54

INTEXT QUESTIONS

1. Write True or False for the following statements

(a) Format picture displays all the images properties in

a separate window.

(b) Activate the image you wish to edit by clicking on it

once with the mouse.

(c) Line charts show the proportion of each component

value to the total value in a data series.

(d) Pie charts are useful to compare the trends over time.

2. Fill in the blanks

(a) Each autoshape can be rotated by first clicking

__________ button on the drawing tool bar.

(b) More __________ effects can be changed using the

picture toolbar.
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(c) ___________ displays all the image properties in a

separate window.

(d) _______________ show the relative contributions that

each data series takes up.

(e) You have to enter the name of the chart and titles for

_____________.

8.6 WHAT YOU HAVE LEARNT

In this lesson you learnt about the creation of charts and graphics.

On the basis of data entered in a worksheet you can create a bar

chart, line chart or pie chart, you can add title, legend, data labels

and grid lines to the chart. Moreover, you learnt about

autoshapes and clip art also.

8.7 TERMINAL QUESTIONS

1. What is the importance of charts and graphics in providing

information?

2. Briefly explain any five different components of a chart?

3. Explain the process of creating a chart using Chart Wizard

dialog box.

4. Briefly explain the following:

a. Bar charts,

b. Pie charts,

5. List any four features of Chart Formatting toolbar.

6. How do you copy a chart to Word created in Excel 2007?

7. List any five categories of AutoShapes in Excel.

8. You are asked to prepare a flow chart. What kind of

AutoShapes you would like to use?

9. Explain the steps in adding a Clip Art to your worksheet?

10. How do you add a photo or graphic to your worksheet from

existing file?
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11. What is the main differences between (a) a column chart

and (b) a bar chart.

12. Write a note on SmartArt.

8.8 FEEDBACK TO INTEXT QUESTIONS

1. (a) True

(b) True

(c) False

(d) False

2. (a) free rotate

(b) picture

(c) format picture

(d) Area charts

(e) X,Y axes


